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ET-BASE dsPIC30F2010/4011 
 

 
 

 ET-BASE dsPIC30F2010/4011 เปนบอรดไมโครคอนโทรเลอรในตระกูล dsPIC30F ซึ่งเลือกใช
ไมโครคอนโทรเลอรรุน 28 Pin เบอร dsPIC30F2010 หรือ รุน 40 Pin เบอร dsPIC30F4011 ของ 
Microchips เปน MCU ประจําบอรด โดย dsPIC30F2010/4011 เปน MCU ซึ่งใชการประมวลผลขอมูล
แบบ 16 บิต จากคาย Microchips ซึ่งมีจุดเดนในดานของความสามารถในการประมวลผลขอมูลสัญญาณ
แบบดิจิตอลเหมาะอยางย่ิงสําหรับนําไปประยุกตใชในงานควบคุมตางๆ โดยโครงสรางภายในจะเปนการ
ผสมผสานระหวางไมโครคอนโทรลเลอร (MCU) และวงจร DSP (Digital Signal Processing) รวมเขาไว
ดวยกัน หรืออาจเรียก MCU ตระกูล dsPIC30F วาเปน DSC หรือ Digital Signal Controller ก็ได 
 โดยโครงสรางของบอรด ET-BASE dsPIC30F2010/4011 ไดรับการออกแบบใหบอรดมีขนาดเล็ก 
เหมาะตอการนําไปประยุกตใชงานเปนหลัก โดยภายในบอรดไดบรรจุเอาวงจรที่จําเปนตอการใชงาน และ
สะดวกตอการพัฒนาโปรแกรม มีความยืดหยุน สามารถปรบัเปลี่ยนสัญญาณ I/O เพ่ือนําไปประยุกตใชงาน
ในลักษณะตางๆใหสอดคลองและเหมาะสมกับความตองการใชงานไดในหลายๆลักษณะตามตองการ 
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คุณสมบัติของบอรด 
 

 เลือกใช MCU ตระกูล dsPIC30F2010 หรือ dsPIC30F4011 ของ Microchips เปน MCU ประจํา
บอรด โดยคุณสมบัติเดนๆของ MCU ไดแก 
o มีหนวยความจํา Flash 12KByte(dsPIC20F2010) หรือ 48KByte(dsPIC30F4011) 
o มีหนวยความจํา RAM ขนาด 512Byte(dsPIC30F2010) หรือ 2KByte(dsPIC30F4011)  
o มีหนวยความจํา EEPROM ขนาด 1KByte สําหรับเก็บขอมูลใชงาน 
o มีพอรต I/O ขนาด 19 Bit(dsPIC30F2010) หรือ 29 Bit(dsPIC30F4011) 
o มี 16Bit Timer/Counter จํานวน 3 ชุด(dsPIC30F2010) หรือ 5 ชุด(dsPIC30F4011)  
o มี Input Capture จํานวน 4 ชอง 
o มี Output Compare จํานวน 2 ชอง(dsPIC30F2010) หรือ 4 ชอง(dsPIC30F4011) 
o มี ADC 10Bit/500Ksps จํานวน 6 ชอง(dsPIC30F2010) หรือ 9 ชอง(dsPIC30F4011) 
o มี PWM Motor Control จํานวน 6 ชอง พรอม Quadrature Encode Interface(QEI) 
o มี UART จํานวน 1 ชอง(dsPIC30F2010) หรือ 2 ชอง (dsPIC30F4011) 
o มี SPI จํานวน 1 ชอง และ มี I2C จํานวน 1 ชอง 
o มีวงจร Watchdog, Power-ON Reset, PWM  

 ใช Crystal ความถี่ 7.3728MHz สามารถใช PLL คูณความถ่ีเพ่ือ Run ความถ่ี 29.4912MHz ได 
 มีพอรตสื่อสารอนุกรม UART แบบ RS232 จํานวน 1 ชอง สําหรับ dsPIC30F2010 และ 2 ชอง 

สําหรับ dsPIC30F4011 พรอม Jumper สําหรับเลือกใชงาน UART หรือ GPIO ไดตามตองการ 
โดยใชขั้วตอ UART แบบ CPA-4 Pin มาตรฐาน อีทีที 

 มีขั้ว ICSP มาตรฐาน ICD2 แบบ RJ11 สําหรับใชรวมกับชุดพัฒนาโปรแกรมและ Debugger ที่
รองรับการทํางานตามมาตรฐาน ICD2 ของ Microchips เชน ICD2 หรือ Pickit2 ได 

 มี Switch สําหรับสลับสัญญาณระหวาง Program/Debug(PGM) และ ใชงานปรกติ(RUN) พรอม 
LED แสดงโหมดการทํางานของบอรด 

 มีขั้วตอสัญญาณ I/O แบบ Header ขนาด 2x5 จํานวน 3 ชุด และ Header 1x8 Pin อีก 1 ชุด 
 Header 14Pin สําหรับ Character LCD พรอม VR ปรับความสวาง 
 มี Switch Reset สําหรับสั่ง Reset การทํางานของ MCU ภายในบอรด 
 มี LED สําหรับทดสอบการทํางาน โดยใช RB0 ในการควบคุม พรอม Jumper ตัดตอสัญญาณ 
  Power AC/DC Input พรอม Regulate แบบ Switching เบอร LM2575 ขนาด 5V/1A ลดปญหา

ความรอนจากวงจร Regulate และ LED แสดงสถานะแหลงจาย Power  
 ขนาด PCB Size เล็กเพียง 8 x 6 cm. 
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รูปแสดงการจัดขาสัญญาณของ dsPIC30F2010 
 

 
 

รูปแสดงการจัดขาสัญญาณของ dsPIC30F4011 
 

 

 
 

ตารางแสดง คุณสมบัติความแตกตางของ dsPIC30F เบอรตางๆ 
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โครงสรางบอรด ET-BASE dsPIC30F2010/4011 
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 หมายเลข 1 คือ ขั้วตอแหลงจายไฟเลี้ยงวงจรของบอรด ใชกับแหลงจายไฟ 7-20VAC/DC 
 หมายเลข 2 คือ IC Regulate แบบ Switching ขนาด 5V/1A 
 หมายเลข 3 คือ LED TEST สําหรับทดสอบการทํางานของบอรด โดยควบคุมจาก RB0 
 หมายเลข 4 คือ Jumper สําหรับ ตัด ตอ สัญญาณ RB0 กับ LED TEST 
 หมายเลข 5 คือ VR ปรับคา สําหรับใชปรับความสวางของหนาจอแสดงผล LCD 
 หมายเลข 6 คือ ขั้วตอ 14PIN IDE สําหรับเชื่อมตอกับ LCD แบบ Character 
 หมายเลข 7 คือ Jumper สําหรับเลือกรูปแบบการควบคุมขา R/W ของ LCD โดยถาใช MCU รุน 

28Pin ตองเลือกไวดาน GND เสมอและไมสามารถสั่งอานขอมูลจาก LCD ได  
 หมายเลข 8 คือ สวิตช Reset สําหรับ Reset การทํางานของ MCU เม่ืออยูในโหมด Run 
 หมายเลข 9 คือ ขั้วตอ ICD2 สําหรับใชเชื่อมตอกับเครื่องโปรแกรมและดีบักตามมาตรฐาน ICD2 
 หมายเลข 10 คือ สวิตช สําหรับเลือกโหมดการทํางานระหวาง Run(RUN) และ Program(PGM) 
 หมายเลข 11 คือ LED สีแดง แสดงสถานะ PGM เม่ือบอรดทํางานใน Program Mode 
 หมายเลข 12 คือ LED สีเขียว แสดงสถานะ RUN เมื่อบอรดทํางานใน Run Mode 
 หมายเลข 13 คือ ขั้วตอ UART2 ซึ่งมีเฉพาะใน MCU รุน 40 Pin (dsPIC30F4011) เทานั้น โดย

เปนสัญญาณแบบ RS232 โดยใช Pin ของ RF4(RX2) และ RF5(TX2) เปนสัญญาณเชื่อมตอ 
 หมายเลข 14 คือ คือ ขั้วตอ UART1 โดยเปนสัญญาณแบบ RS232 มีอยูใน MCU ทั้งรุน 28 Pin 

และรุน 40 Pin ซึ่งใช Pin ของ RC13(TX1),RC14(RX1) เปนสัญญาณเชื่อมตอ 
 หมายเลข 15 คือ Jumper สําหรับเลือกการเชื่อมตอสัญญาณ RC13,RC14,RF4,RF5 วาจะใช

ขาสัญญาณดังกลาวทําหนาที่เปนขาสัญญาณรับสงของ RS232 หรือ GPIO สําหรับใชงานทั่วไป 
 หมายเลข 16 คือ ขั้วตอสัญญาณ RC13,RC14,RD0,RD1,RD2 และ RD3 สําหรับใชงาน โดยถา

เปน MCU รุน 28Pin จะไมมีสัญญาณ RD2 และ RD3 ขาสัญญาณดังกลาวจะปลอยวางไว 
 หมายเลข 17 คือ ขั้วตอสัญญาณ Port-RF ซึ่งถาเปน MCU รุน 40 Pin จะมี 7 บิต คือ RF[0..6] 

แตถาเปน MCU รุน 28 Pin จะมีเพียง 2 บิต คือ RF[2] และ RF[3] เทานั้น 
 หมายเลข 18 คือ LED สําหรับแสดงสถานะ ของแหลงจายไฟ +5V ของบอรด 
 หมายเลข 19 คือ ขั้วตอสัญญาณ Port-RE ซึ่งจะมี 7 บิต คือ RE[0..6 และ 8]  
 หมายเลข 20 คือ ขั้วตอสัญญาณ Port-RB ซึ่งถาเปน MCU40Pin จะมี 8 บติ คือ RB[0..7] แตถา

เปน MCU 28Pin จะมีเพียง 6 บิต คือ RB[0..5] เทานั้น 
 หมายเลข 21 คือ MCU ประจําบอรด โดยถาเปน รุน 28Pin จะใชเบอร dsPIC30F2010 แตถาเปน

รุน 40Pin จะใชเบอร dsPIC30F4011 
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ขั้วตอสัญญาณตางๆ 
  

ET-BASE dsPIC30F2010 ET-BASE dsPIC30F4011 
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รูปแสดง การจัดเรียงสัญญาณของพอรต I/O ตางๆของบอรด ET-BASE dsPIC30F2010/4011 
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การใชงาน LCD แสดงผล 
 

สําหรับการเชื่อมตอ LCD นั้นจะสามารถใชไดกับ LCD แบบ Character Dot-Matrix เทานั้น โดย
เชื่อมตอแบบ 4 บิต Data โดยสัญญาณที่ใชเชื่อมตอกับ LCD จะใชสัญญาณจาก RB[0..5] จํานวน 6บิต 
ซึ่งถาใช dsPIC30F4011 สามารถเลือกกําหนดใหใชสัญญาณ RB8 เพ่ือกําหนดการอานขอมูลกลับจาก 
LCD ไดดวย โดยการเลือก Jumper R/W LCD PIN ไวทางดาน RB8 หรือเลือกไวทางดาน GND เมื่อไม
ตองการอานขอมูลกลับจาก LCD ไดตามตองการ แตสําหรับกรณีที่ใช dsPIC30F2010 จะไมมีขาสัญญาณ 
RB8 จึงไมสามารถสั่งอานขอมูลกลับจาก LCD ได และตองเลือก Jumper ไวทางดาน GND เสมอ โดยใน
การเชื่อมตอสายสัญญาณจากขั้วตอของ พอรต LCD ไปยังจอแสดงผล LCD นั้น ใหยึดชื่อสัญญาณเปน
จุดอางอิง โดยใหตอสัญญาณที่มีชื่อตรงกันเขาดวยกันใหครบทั้ง 14 เสน ดังรูป 

 

สัญญาณการเช่ือมตอกับ LCD 
 

 RS   = RB4 
 EN   = RB5 
 RW   = GND/RB8 
 DB4 = RB0  
 DB5 = RB1 
 DB6 = RB2 
 DB7 = RB3 
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การใชงาน RS232 
 

พอรต RS232 เปนสัญญาณ RS232 ซึ่งผานวงจรแปลงระดับสัญญาณจาก MAX3232 เรียบรอย
แลว โดยถาใช dsPIC30F2010 จะมี UART จํานวน 1 ชอง แตถาใช dsPIC30F4011 จะมีวงจร UART ใช
งาน จํานวน 2 ชอง โดยสัญญาณของ RS232 แตละชอง จะจัดขั้วเปนแบบ CPA-4PIN (RS232) ดังรูป 
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 โดยวงจรการทํางานของ UART(RS232) ทั้ง 2 ชอง สามารถเลือกใชงาน หรือ ไมใชงาน จาก 
Jumper ได เพ่ือใชเลือกวาจะใหสัญญาณของ MCU ทําหนาที่เปน I/O หรือ UART ดังวงจร 
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สําหรับ Cable ที่จะใชในการเชื่อมตอ RS232 ระหวาง Comport ของเครื่องคอมพิวเตอร PC เขา
กับขั้วตอ RS232 ของบอรด ET-BASE dsPIC30F2010/4011 นั้น เปนดังนี้ 
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รูป แสดงวงจรสาย Cable สําหรับ RS232 
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การใชงาน ICD2 
 

ICD2 จะเปน Connector แบบ RJ11 สําหรับ Interface กับเครื่องมือพัฒนาโปรแกรมตระกูล PIC 
ที่มีการจัดขั้วตามมาตรฐาน ICD2 ของ Microchips เชน ICD2,ICD3,Pickit2 หรือ Pickit3 ซึ่งสามารถใช
งานไดกับเครื่องมือพัฒนาของ Microchips หรือ เทียบเทา เชน ET-PGMPIC USB(เทียบเทา Pickit2) หรือ 
ET-ICDX(เทียบเทา ICD2) โดยจะมีสวิตชสําหรับเลือกตัดตอสัญญาณของ RF2, RF3 และ MCLR สําหรับ
ใชทําหนาที่เชื่อมตอกับ Programmer/Debugger หรือ ใชงานตามปรกติได พรอม LED แสดงสถานะ วา
การทํางานของสวิตชอยูในตําแหนงใด โดยถาเลือกสวิตชไวทางดาน Programmer/Debugger จะเห็น LED 
สีแดงของ PGM ติดสวางใหเห็น แตถาตําแหนงของสวิตชอยูดาน Run จะเห็น LED สีเขียว(RUN) ติดสวาง
ใหเห็น โดยมีการจัดวงจรและสัญญาณตามมาตรฐานของ ICD2 ดังนี้ 
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รูปแสดง การตอบอรดกับเคร่ืองโปรแกรม ET-ICDX(ซาย) และ ET-PGM PIC USB(ขวา) 
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วงจรภาคจายไฟ 
 
 สําหรับวงจรภาคจายไฟของบอรด จะใชวงจร Bridge Rectifier รวมกับ Switching Regulate 
ขนาด 5V/1A สามารถใชงานไดทั้งกับไฟ AC และ DC ขนาดต้ังแต 7V-20V ได 
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การพัฒนาโปรแกรมของบอรด 
 สําหรับการพัฒนาโปรแกรมของบอรด “ET-BASE dsPIC30F” นั้น จะแบงออกเปน 2 สวนดวยกัน 
คือ สวนของการพัฒนาโปรแกรม และการ Download โปรแกรม โดยในสวนของการพัฒนาโปรแกรมของ
บอรดนั้น จะเปนการเขียนโปรแกรมเพ่ือควบคุมและสั่งงานให MCU สามารถทํางานตามจุดประสงคที่ได
ออกแบบไว ซึ่งในสวนนี้เปนหนาที่ของผูพัฒนาโปรแกรม วาจะเลือกใชภาษาใดในการพัฒนาโปรแกรม รวม
ไปถึงการเลือกใชโปรแกรมสําหรับทําหนาที่แปลคําสั่งของภาษานั้นๆ ใหเปนรหัสคําสั่งในรูปแบบของ HEX 
File สําหรับใช Download ใหกับหนวยความจําโปรแกรม (Flash Memory) ของ MCU เพ่ือสั่งงานให MCU 
ปฏิบัติตามคําสั่งในโปรแกรมที่ผูพัฒนาโปรแกรมเขียนขึ้นมา 
 สําหรับสวนของการ Download โปรแกรม หรือการ Download HEX File ที่ไดจากการพัฒนา
โปรแกรมใหกับหนวยความจําโปรแกรม (Flash Memory) ของ MCU นั้น จะตองอาศัยเครื่องมือทาง
ฮารดแวรเปนสวนประกอบในการพัฒนาโปรแกรมดวย ซึ่งในกรณีของบอรด “ET-BASE dsPIC30F2010” 
และ “ET-BASE dsPIC30F4011” นั้น ถูกออกแบบใหใชกับเครื่องมือพัฒนาโปรแกรมที่มีคุณสมบัติตรงตาม
มาตรฐาน ICD2 ของ Microchips ซึ่งจะมีความสะดวกมากในการพัฒนาโปรแกรมรวมกับชุดโปรแกรม 
MPLAB และ C30 ของ Microchips เพราะสามารถเขียนโปรแกรม และ Download Code เพื่อทดสอบการ
ทํางาน รวมทั้งการตรวจสอบหาขอผิดพลาดตางๆไดโดยงายและสะดวก ซึ่งสามารถใชงานไดกับเครื่องมือ
ของ Microchips หรือเทียบเทาไดหลายรุนดังรูป (รุนเครื่องมือที่รองรับคือรุนที่มีสัญลักษณสีเขียวหนาชื่อ) 
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การเขียนโปรแกรมใชงานกับบอรดโดยใช MPLAB C30 
 MPLAB C30 หรือ C30 Tools เปนโปรแกรมภาษาซี สําหรับใชแปลคําสั่งของ MCU ตระกูล dsPIC 
ซึ่งไดรับการพัฒนาขึ้นโดย Microchips เอง โดยขอกําหนดและรายละเอียดของการเขียนโปรแกรมภาษาซี
นั้น จะไมกลาวถึงในที่นี้ดวย โดยถาผูใชตองการพัฒนาโปรแกรมใหกับ dsPIC ดวยภาษาซี แตยังไมมี
ความรูเร่ืองการเขียนโปรแกรมภาษาซีเลยนั้นขอแนะนําให หาหนังสือที่อธิบายเกี่ยวกับการเขียนโปรแกรม
ภาษาซีในสวนที่เปนมาตรฐานตามขอกําหนดของ “ANSI C” มาศึกษาใหเขาใจเสียกอน และสําหรับสวน
ของขอกําหนดปลีกยอยอื่นๆที่เปนของ MPLAB C30 เองก็สามารถอานเพ่ิมเติมไดจากเอกสารและคูมือการ
ใชงานของ MPLAB C30 ที่ทาง Microchips จัดทําไวได โดยสามารถ Download จาก Website ของ 
Microchips หรือจาก Folder ของ “..\MPLAB C30\docs” ที่ทําการติดต้ังโปรแกรม MPLAB C30 ไวก็ได 
โดยในที่นี้ จะขอกลาวแนะนําถึงเฉพาะสวนของการกําหนดคาตัวเลือกในโปรแกรมเพ่ือใชงานรวมกับบอรด 
“ET-BASE dsPIC30F2010/4011” เทานั้น โดยในการที่จะใชงานโปรแกรม MPLAB C30 ในการเขียน
โปรแกรมนั้น ผูใชจําเปนตองทําการติดต้ังโปรแกรมของ Microchips จํานวน 2 โปรแกรมดังนี้คือ 
 

 MPLAB IDE ซึ่งเปนโปรแกรม Text Editor ของ Microchips ซึ่งในปจจุบัน (ตุลาคม 2552) 
จะเปนรุน 8.40 แลวสามารถ Download มาใชงานไดฟรีจาก Web ของ Microchips 

 MPLAB C30 ซึ่งเปนตัวแปลภาษาซี (C Complier) ใหเปนรหัสคําสั่งของ dsPIC โดยใน
ปจจุบัน(ตุลาคม 2552) จะเปน Version 3.20B ซึ่งตามปรกติแลวโปรแกรมชุดนี้จะตองซื้อ
มาใชงานเอง แตอยางไรกต็ามทาง Microchips เองมีรุนทดลองใชงานใหผูใชสามารถ 
Download มาใชงานไดเชนเดียวกันกับ MPLAB IDE 

 

โดยโปรแกรมทั้ง 2 ชุดนี้ ทางอีทีที ไดทําการ Download มาจัดเตรียมไวใหในแผน CD-ROM ที่แถม
ไปกับบอรดของ “ET-BASE dsPIC30F2010/4011” ดวยอยูแลว โดยในการติดตั้งโปรแกรมนั้นขอแนะนําให
ผูใชทําการติดต้ังโปรแกรมในชุดของ MPLAB IDE กอนเปนอันดับแรก โดยขอแนะนําใหติดต้ังโปรแกรมของ 
MPLAB IDE ไวตามคา Default ของโปรแกรมติดตั้งเลย คือ “C:\Program Files\Microchip\MPLAB IDE\" 
จะสะดวกตอการใชงานมากกวา ซึ่งหลังจากทําการตดิต้ังโปรแกรม MPLAB IDE เสร็จเรียบรอยแลวในครั้ง
แรกกอนการใชงานนั้นตองสั่ง Restart เครื่องคอมพิวเตอรกอน หลังจากนั้นแลว MPLAB IDE จึงจะ
สามารถทํางานไดโดยไมเกิดปญหา จากนั้นจึงทําการติดต้ังโปรแกรม MPLAB C30 เปนลําดับถัดไป โดยขอ
แนะนําใหทําการติดต้ังโปรแกรมชุดนี้ไวตามคา Default คือ C:\Program Files\Microchip\MPLAB C30\” 
จะเกิดความสะดวกตอการใชงานมากที่สุด โดยเฉพาะในขั้นตอนของการกําหนดการเชื่อมโยงการทํางาน
ระหวาง MPLAB IDE และ MPLAB C30 โดยในที่นี้จะขออธิบายโดยอางถึงตําแหนงการติดตั้งโปรแกรม
ดังที่กลาวไวแลวขางตนเทานั้น ซึ่งถาผูใชทําการสั่งติดต้ังโปรแกรมไวยังตําแหนง Folder ที่แตกตางไปจากนี้
แลวขอใหทําความเขาใจและดัดแปลงวิธีการกําหนดคาเองตามที่ติดต้ังโปรแกรมไวจริงๆดวย 
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การกําหนดการเชื่อมโยงการทํางานของ MPLAB IDE และ MPLAB C30 
 หลังจากทําการติดต้ังโปรแกรม MPLAB IDE และ MPLAB C30 เสร็จเรียบรอยแลว กอนที่จะ
เริ่มตนใชงานโปรแกรม MPLAB C30 ไดนั้น ในครั้งแรกจะตองทําการสั่งกําหนดการเชื่อมโยงการทํางาน
ระหวาง MPLAB IDE และ MPLAB C30 ใหถูกตองเรียบรอยเสียกอน จึงจะสามารถเรียกใชงานโปรแกรม 
MPLAB C30 ผานทางโปรแกรม MPLAB IDE ไดอยางถูกตอง ทั้งนี้ก็เนื่องมาจากวา โปรแกรม MPLAB 
C30 นั้นจะเปนเพียงตัวแปลคําสั่ง Text File ที่เปนภาษาซี (รวมทั้งภาษา Assembly) ใหเปนรหัสคําสั่งของ 
dsPIC ในรูปแบบของ Hex File เพียงอยางเดียวเทานั้น สวนการเขียนโปรแกรม Source Code นั้นจะอาศัย
โปรแกรม MPLAB IDE เปนหลัก ซึ่งการสั่งแปลคําสั่งก็จะตองกระทําผานเมนูคําสั่งของ MPLAB IDE ดวย 
เชนเดียวกัน ซึ่งตามปรกติแลว MPLAB IDE สามารถเชื่อมโยงการทํางานรวมกับโปรแกรมอื่นๆไดอีกหลาย
โปรแกรม ไมไดใชงานเฉพาะกับ MPLAB C30 เพียงอยางเดียวเทานั้น 
 โดยในชุดโปรแกรมของ MPLAB C30 หลังจากติดตั้งโปรแกรมไปแลว โปรแกรม ใชงานตางๆจะถูก
เก็บไวใน Folder ชื่อ “C:\Program Files\Microchip\MPLAB C30\bin\” โดยจะมีโปรแกรมหลักๆที่ตอง
กําหนดการเชื่อมโยงการทํางานกับ MPLAB IDE อยูดวยกัน 4 โปรแกรมดวยกันคือ 
 

 ไฟล “pic30-as.exe” ซึ่งเปนตัวโปรแกรมหลักสําหรับใชในการสั่งงานในการแปลคําสั่ง
ภาษาแอสแซมบลี้ของ dsPIC (Assembler) 

 ไฟล “pic30-gcc.exe” ซึ่งเปนโปรแกรมหลักสําหรับใชในการสั่งงานในการแปลคําสั่ง
ภาษาซีของ dsPIC (C Complier) 

 ไฟล “pic30-ld.exe” ซึ่งเปนโปรแกรมหลักสําหรับใชในการรวมไฟลตางๆเขาดวยกันเพ่ือ
สรางเปน Hex File ของ dsPIC (Linker) 

 ไฟล “pic30-ar.exe” ซึ่งเปนโปรแกรมหลักในการจัดการกับ Library  
 

ซึ่งในอันดับแรกกอนที่จะเร่ิมตนเขาสูขั้นตอนของการใชงานนั้น จะตองทําการกําหนดการเชื่อมโยง
คําสั่ง ระหวางโปรแกรม MPLAB IDE และ MPLAB C30 ใหเรียบรอยเสียกอน เพ่ือที่โปรแกรม MPLAB IDE 
จะไดทราบวาจะตองไปเรียกใชไฟลตางๆของ MPLAB C30 จากที่ใด โดยในการกําหนดการเชื่อมโยง
โปรแกรมทั้ง 4 ใหสามารถใชงานกับ MPLAB IDE นั้นสามารถทําไดตามลําดับขั้นตอนตอไปนี ้

 
1. สั่ง Run โปรแกรม MPLAB IDE โดยอาจเรียกจาก “ICON” ของโปรแกรมหรือเรียกผาน Windows 

จาก “Start → Program → PIC development Tools → Microchip MPLAB→ MPLAB”  
2. คลิกเมาสที่คําสั่ง “Project → Set Language Tools Locations..” แลวเลือกกําหนดการใชงาน

โปรแกรม MPLAB IDE รวมกับโปรแกรม MPLAB C30 แลวเลือก “OK” ดังรูป 
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 เม่ือมาถึงขั้นตอนนี้ใหทําการคลิกเมาสที่บริเวณตําแหนงเครื่องหมายบวก(+) ทีหนาคําสั่งของ 
Microchip C30 Toolsuite ซึ่งจะไดผลดังรูป 
 

 
 
 ซึ่งจะเห็นไดวาในหัวขอ Microchip C30 Toolsuite นี้จะประกอบไปดวยหัวขอยอยอีก 2 หัวขอ คือ 
Executables และ Default Search Paths & Directories 
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 ใหทําการกําหนดตําแหนงของไฟลของ MPLAB C30 ที่ตองการให MPLAB IDE เรียกใช ซึ่งจะมีอยู
ดวยกันทั้งหมด 4 ไฟล โดยใหคลิกเมาส ที่บริเวณตําแหนงเครื่องหมายบวก (+) ที่หนาหัวขอ Executables 
ซึ่งจะไดผลดังรูป 
 

 
 

 ในขั้นตอนนี้ใหทําการกําหนดชื่อ และ ตําแหนง Folder ที่อยูของไฟลทั้ง 4 ซึ่งไดแก pic30-ar.exe, 
pic30-as.exe, pic30-gcc.exe และ pic30-ld.exe โดยใหทําการคลิกเมาสที่รายการยอยของแตละหัวขอ
จนปรากฏแถบสีน้ําเงินที่หัวขอนั้นๆจากนั้นก็ใหกําหนดตําแหนง Folder และชือ่ของไฟล ใหกับแตละหัวขอ
จนครบทั้ง 4 หัวขอ โดยชื่อไฟลนั้นตองกําหนดตามชื่อที่อยูในวงเล็บทายหัวขอ สวนตําแหนง Folder นั้น
ตามปรกติแลวจะอยูที่ “..\MPLAB C30\bin\” เชน ถาติดตั้งโปรแกรม MPLAB C30 ไวตามที่แนะนําไวใน
ตัวอยางคือ “C:\Program Files\Microchip\MPLAB C30\” ไฟลที่ใชสั่ง Run (Execute) ทั้งหมดจะอยูที่ 
“C:\Program Files\Microchip\MPLAB C30\bin\” 
 โดยวิธีการกําหนดชื่อและตําแหนง Folder ที่อยูของไฟล นั้นสามารถทําได 2 แบบ คือ การสั่งคลิก
เมาสที่ “Browse…” เพ่ือกําหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ Execute File ไว โดยใหชี้ไปที่ 
“..\MPLAB C30\bin\..” ตัวอยางเชน ถาตองการกําหนดชื่อ Execute File และตําแหนง Folder ของไฟล
สําหรับ LIB30 Archiver (pic30-ar.exe) ตองกําหนดชื่อไฟลเปน “pic30-ar.exe” โดยใหคลิกเมาสที่ 
“Browse…” แลวชี้ไปที่ “C:\Program Files\Microchip\MPLAB C30\bin\pic30-ar.exe” หรืออาจใช
วิธีการพิมพ ชื่อ Folder ในชอง Location เองเปน “C:\Program Files\Microchip\MPLAB C30\bin\pic30-
ar.exe” ก็ได (ถาติดตั้งโปรแกรมไวตางจากนี้ตองกําหนดใหตรงกับที่ติดต้ังไวจริงดวย) 
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 โดยในขั้นตอนนี้ ใหกําหนดชื่อและตําแหนง Folder ของ Execute File ใหครบทั้ง 4 หัวขอ ดวย ดัง
รูปในตัวอยางตอไปนี ้

 
 

รูปแสดง ลักษณะการกําหนด Execute File ของ LIB30 Archiver 
 

↓ 
 

 
 

รูปแสดง ลักษณะการกําหนด Execute File ของ MPLAB ASM30 Assembler 
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รูปแสดง ลักษณะการกําหนด Execute File ของ MPLAB C30 C Complier 
 

↓ 
 

 
 

รูปแสดง ลักษณะการกําหนด Execute File ของ MPLAB LINK30 Object Linker 
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 เม่ือมาถึงขั้นตอนนี้ใหทําการคลิกเมาสที่บริเวณตําแหนงเครื่องหมายบวก(+) ทีหนาคําสั่งของ 
Default Search Patchs & Directories ซึ่งจะไดผลดังรูป 
 

 
 

เม่ือมาถึงขั้นตอนนี้ใหทําการคลิกเมาสที่ “Assembler Include Search Path, $(AINDIR)” จน
ปรากฏแถบสีน้ําเงินดังรูป แลวจึงคลิกเมาสที่ “Browse…” เพ่ือกําหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ 
Source Code ภาษา Assembly ไว โดยใหชี้ไปที่ “..\MPLAB C30\support\dsPIC30F\gld” หรืออาจใช
วิธีการพิมพ ชื่อ Folder ในชอง Location เองก็ได (ถาติดต้ังโปรแกรมไวตางจากนี้ตองกําหนดใหตรงดวย) 
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เม่ือมาถึงขั้นตอนนี้ใหทําการคลิกเมาสที่ “Include Search Path, $(INCDIR)” จนปรากฏแถบสีน้ํา
เงินดังรูป แลวจึงคลิกเมาสที่ “Browse…” เพ่ือกําหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ Header File ไว 
โดยในการกําหนดตําแหนง Folder นั้นใหชี้ไปที่ “..\MPLAB C30\support\dsPIC30F \h” หรืออาจใชวิธีการ
พิมพ ชื่อ Folder ในชอง Location เองก็ไดดังรูป (ถาติดต้ังโปรแกรมไวตางจากนี้ตองกําหนดใหตรงดวย) 
 

 
 

เม่ือมาถึงขั้นตอนนี้ใหทําการคลิกเมาสที่ “Library Search Path, $(LIBDIR)” จนปรากฏแถบสีน้ํา
เงินดังรูป แลวจึงคลิกเมาสที่ “Browse…” เพ่ือกําหนดตําแหนงที่อยูของ Folder ซึ่งเก็บ Library File ไว โดย
ในการกําหนดตําแหนง Folder นั้นใหชี้ไปที่ “..\MPLAB C30\support\dsPIC30F \lib” หรืออาจใชวิธีการ
พิมพ ชื่อ Folder ในชอง Location เองก็ไดดังรูป (ถาติดต้ังโปรแกรมไวตางจากนี้ตองกําหนดใหตรงดวย) 
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ตัวอยางการสรางโปรแกรมภาษาซีของ MPLAB C30 
เม่ือทําการกําหนดการเชื่อมโยงคําสั่งระหวาง MPLAB IDE และ MPLAB C30 เปนที่เรยีบรอยแลว 

ตอจากนี้ไป ผูใชก็สามารถทําการเรียกใชงานโปรแกรม MPLAB C30 ผานทางโปรแกรม MPLAB IDE ได
แลว โดยคาตัวเลือกตางๆที่ไดกําหนดไวแลวนั้นจะถูกเก็บไวใน Configuration ของโปรแกรมตลอดไป 
จนกวาจะมีการสั่งเปลี่ยนแปลงใหม ซึ่งในที่นี้จะขอยกตัวอยางการเขยีนโปรแกรมภาษาซี ของ MPLAB C30 
สัก 1 ตัวอยางพอเปนแนวทางใหผูใชทําความเขาใจ โดยมีลําดับขั้นตอนดังนี ้

1. สั่ง Run Program ของ MPLAB IDE ขึ้นมา จากนั้นก็สั่งสรางไฟลใหมขึ้นมา 1 ไฟล สําหรับเขียน 
Source Code ภาษาซี โดยใชคําสั่ง “File → New” จากนั้นใหทําการพิมพ Source Code ภาษาซี
ใน Work Sheet ของโปรแกรม MPLAB IDE ดังตัวอยาง 

 

 
 

2. ทําการสั่งบันทึกไฟลที่เขียนขึ้นใหเปน Text File ภาษาซี โดยใหทดลองกําหนดชื่อเปน “main.c” 
แลวสั่งบันทึกไวใน Folder ชื่อ C:\Program Files\Microchip\MPLAB C30\examples\demo1\” 
โดยในที่นีใ้หใชคําสั่ง “File → Save As…” แลวสราง Folder ชื่อ demo1 ไวภายใต Folder ของ 
examples อีกชั้นหนึ่ง แลว กําหนดชื่อเปน “main.c” แลวเลือก “Save” ดังรูป 
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 ซึ่งจะเห็นวาเม่ือทําการสั่งบันทึกไฟลเปน “main.c” ไปแลว กลุมของตัวอักษรตางๆที่ไดพิมพไว จะ
ถูกจัดแบงกลุม โดยใชสีในการแสดงผลที่แตกตางกันไปตามหนาที่ของกลุมตัวอักษร เชน กลุมตัวอักษรที่ใช
เปนคําอธิบาย (Comment) กลุมตัวอักษรที่เปนคําสั่ง และกลุมตัวอักษรที่เปนตัวแปรตางๆ ซึ่งจุดนี้เปนขอดี
ของ MPLAB IDE ที่สามารถแยกการแสดงผลกลุมตัวอักษรตามหนาที่การใชงานได ทําใหเราสามารถอาน
โปรแกรมไดงายและสะดวกมากย่ิงขึ้นดังรูป 
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#include "p30f4011.h"                 // dsPIC30F4011 MPU Register 
 
/* Setup Configuration For ET-BASE dsPIC30F4011 */ 
_FOSC(CSW_FSCM_OFF & XT_PLL16);       // Disable Clock Switching 
                                      // Enable Fail-Salf Clock 
                                      // Clock Source=Primary XT + (PLLx16) 
_FWDT(WDT_OFF);           // Disable Watchdog  
_FBORPOR(PBOR_OFF & MCLR_EN);         // Disable Brown-Out ,Enable MCLR 
_FGS(CODE_PROT_OFF);          // Code Protect OFF 
/* End   Configuration For ET-BASE dsPIC30F4011 */ 
 
/* pototype  section */ 
void delay_led(unsigned long int);    // Delay Time Function 
 
int main(void) 
{   
  TRISBbits.TRISB0 = 0;          // Config RB0 = Output 
   
  // Loop Blink LED on RB0 // 
  while(1)            // Loop Continue 
  { 
    LATBbits.LATB0 = !LATBbits.LATB0; // Toggle RB0 (1=ON LED, 0=OFF LED) 
    delay_led(100000);          // Display LED Delay 
  }    
}    
 
/***********************/ 
/* Delay Time Function */ 
/*    1-4294967296     */ 
/***********************/ 
void delay_led(unsigned long int count1) 
{ 
  while(count1 > 0) {count1--;}   // Loop Decrease Counter  
} 

แสดง ตัวอยาง Source Code สําหรับใชทดลองการทํางาน 
 

 สําหรับตัวอยางนี้จะเปนการสั่งใหใชพอรต RB0 ทําหนาที่เปน Output ขับ LED ใหติดและดับ
สลับกันไปไมรูจบในลักษณะของไฟกระพริบ ซึ่งวิธีการทดสอบการทํางานของโปรแกรมนี้ โดยใชกับบอรด 
ET-BASE dsPIC30F4011 นั้นทําไดโดยตอสัญญาณจาก RB0 เขากับ LED Output ของบอรด โดยจะเห็น
ผลการทํางานของโปรแกรมแกรม คือ LED จะกระพริบ ติดและดับอยางตอเนื่องตลอดเวลา 

สวนที่นาสนในของโปรแกรมคือบรรทัดคําสั่ง  
/* Setup Configuration For ET-BASE dsPIC30F2010/4011 */ 
_FOSC(CSW_FSCM_OFF & XT_PLL16);       // Disable Clock Switching 
                                      // Enable Fail-Salf Clock 
                                      // Clock Source=Primary XT + (PLLx16) 
_FWDT(WDT_OFF);           // Disable Watchdog  
_FBORPOR(PBOR_OFF & MCLR_EN);         // Disable Brown-Out ,Enable MCLR 
_FGS(CODE_PROT_OFF);          // Code Protect OFF 
/* End   Configuration For ET-BASE dsPIC30F4011 */ 

 
โดยในสวนนี้เปนสวนของการกําหนดคา Configuration ของ MCU เบอร “dsPIC30F2010/4011” 

เพ่ือใชกับบอรด “ET-BASE dsPIC30F2010/4011”  
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3. ทําการสราง Project File เพ่ือใชสั่งผนวกไฟลตางๆ ที่เกี่ยวของเขาดวยกัน ทั้งนี้เนื่องมาจากวา
ภาษาซีของ MPLAB C30 นั้น ถูกออกแบบใหมีความออนตัวในการใชงาน ดังนั้นจึงมีการจัดสราง
และแบงแยกไฟลออกเปนหลายๆไฟลตามหนาที่การใชงาน เพื่อใหผูใชสามารถเรียกไฟลตางๆ
เหลานั้นเขามาใชงานรวมกับ Source Code  ที่เขียนขึ้นมาไดไดงาย โดยไมตองเสียเวลาเขียน 
Source Code เองทั้งหมด ซึ่งจะทําใหผูใชสามารถลดเวลาในการเขียนโปรแกรมไปไดเปนอยาง
มากเนื่องจากเพียงแตทําการสั่งผนวกไฟลที่ทาง MPLAB C30 สรางเตรียมไวให เขากับ Source 
Code ที่ผูใชเขียนขึ้นใหมแลวสั่งแปลโปรแกรมก็จะไดไฟลที่มีความสมบูรณตอการใชงานแลว โดย
จากตัวอยาง Source Code ที่ไดทดลองเขียนไปแลวในขางตน ก็เชนเดียวกัน จะเห็นไดวามีการสั่ง
ผนวกไฟลชื่อ “p30f2010.h” หรือ “p30f4011.h” เขามาใชงานดวย ซึ่งทําใหไมตองเสียเวลาไปสั่ง
ประกาศชื่อและตําแหนงรีจิสเตอรตางๆของ dsPIC30F2010/4011 ใหเสียเวลา แตสามารถอางถึง
ชื่อของรีจสิเตอรตางๆในโปรแกรมไดทันที โดยวิธีการกําหนดคุณสมบัติของ Project File มีดังนี ้
 สั่งกําหนดคุณสมบัติของ project File โดยใชคําสั่ง “Project → Project Wizard…” ซึ่ง

จะไดผลดังรูป จากนั้นใหเลือก “Next >” เพ่ือไปยังขั้นตอนตอไป 
 

  
 
 หลังจากเลือก “Next >” แลว โปรแกรมจะรอใหกําหนดเบอรของ MCU ที่จะใชงานรวมกับ
โปรแกรมที่เขียนขึ้น ซึ่งใหเลือกกําหนดเปน “dsPIC30F4011” จากนั้นเลือก “Next >” เพ่ือขามไปทํางานยัง
ขั้นตอนตอไปดังรูป 
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 ในขั้นตอนนี้จะเปนการเลือกวาจะใชโปรแกรมชุดใดในการแปลคําสั่ง เนื่องจาก MPLAB IDE 
สามารถใชงานไดกับชุดโปรแกรมตางๆมากมายหลายโปรแกรม ซึ่งในที่นี้ใหเลือกกําหนดใชโปรแกรม ของ 
MPLAB C30 โดยการเลือกกําหนดตัวเลือกของ “Active Toolsuite” ใหเปนของ MPLAB C30 โดยกําหนด
ตัวเลือกเปน “Microchip C30 Toolsuite” ดังรูป แลวเลือก “Next >” 
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ในขั้นตอนนี้จะเปนการ กําหนดชื่อ Project และตําแหนง Folder ที่จะใชเก็บไฟลตางๆที่ไดจากการ
ทํางานของ Project โดยใหกําหนดชื่อเปน “led_blink” แลวกําหนดตําแหนง Folder เปน demo1 โดย
กําหนดไวภายใต Folder ชื่อ examples ของ MPLAB C30 ดังรูป แลวเลือก “Next >” 

 

 
 

 
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 ในขั้นตอนนี้จะเปนการสั่งผนวกไฟลตางๆเขาไวดวยกันภายใตชื่อ Project ของ led_blink โดยให
ทําการสั่งผนวกไฟลทั้งหมด 3 ไฟลเขาไวใน Project ดังนี ้
 

 สั่งผนวกไฟลชื่อ “main.c” ซึ่งเปน Source Code ที่เราไดเขียนและสั่งบันทึกไวแลวกอน
หนานีใ้น C:\Program Files\Microchip\MPLAB C30\examples\demo1\main.c” 

 สั่งผนวกไฟลชื่อ “p30f4011.gld” ซึ่งเปน Script File ของ dsPIC30F4011 ที่ทาง MPLAB 
C30 สรางเตรียมไวให ถาใช dsPIC30F2010 ใหเลือกเปน “p30f2010.gld” โดยถาติดตั้ง
โปรแกรมตามตัวอยางไฟลดังกลาวจะเก็บอยูใน “C:\Program Files\Microchip\MPLAB 
C30\support\dsPIC30F\gld\” 

 
โดยในการสั่งผนวกไฟลทั้ง 2 ดังกลาวใหทําการคลิกเมาสไปยัง “ICON” ของไฟลจากตําแหนง 

Folder ที่กลาวไวในขางตนที่ผานมาแลวเลือก “Add >>” จนชื่อไฟลดังกลาวไปปรากฏอยูที่กรอบหนาตาง
ดานขวาของโปรแกรม ซึ่งใหเลือกทําตามวิธีการนี้จนสามารถสั่ง “Add” ไฟลไดครบทั้ง 2 ไฟล แลวเลือก 
“Next >” เพ่ือไปยังขั้นตอนตอไปดังรูป 

 

 
 
↓ 
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 เม่ือสั่งผนวกไฟลทั้งหมดเขากับ Project ไฟลที่สรางขึ้นเปนที่เรียบรอยแลว โปรแกรมจะรายงานผล 
โดยแสดงคาพารามิเตอรตางๆที่ไดกําหนดไวแลวใหทราบดังรูป ใหเลือก “Finish” เปนอันเสร็จขั้นตอนของ
การสราง Project File ของ led_blink  
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 ซึ่งหลังจากกําหนดคาตางๆใหกับ Project File เปนที่เรียบรอยแลว ผูใชก็สามารถทําการสั่งแปล
คําสั่งของโปรแกรม “main.c” ที่เขียนขึ้นไดทันที โดยใชคําสั่ง “Project → Build All” ซึ่งจะทําใหไดไฟล 
Output มีชื่อเดียวกับ Project File ที่สรางไวแตมีนามสกุลเปน HEX ซึ่งจากตัวอยาง Project นี้เมื่อสั่งแปล
โปรแกรมแลวถาไมเกิดขอผิดพลาดใดๆจะได Output ไฟลชื่อ “led_blink.hex” โดยไฟลดังกลาวจะถูกสราง
และเก็บไวใน Folder ของ Project คือ  “C:\Program Files\Microchip\MPLAB C30\examples\demo1\” 
โดยผูใชสามารถสั่ง Download Hex File ชื่อ “led_blink.hex” นี้ใหกับบอรดเพ่ือทดสอบการทํางานไดทันท ี
 

 
 
 ซึ่งในกรณีที่มีเครื่องโปรแกรมตอไวกับบอรดเรียบรอยแลว ผูใชสามารถเลือกสวิตชเพื่อเปลี่ยนโหมด
การทํางานของบอรดมาไวที่ PGM (LED PGM สีแดงติดสวาง) จากนั้นเลือกที่เมนคํูาสั่งในโปรแกรม 
MPLAB โดยใหเลือกที ่Programmer-> Select Programmer แลวเลือกรุนของเครื่องมือที่ใชอยูจริง 

 ในกรณีทีใชเครื่องโปรแกรมของ อีทีที รุน ET-ICDX ใหเลือกเปน MPLAB ICD2 
 ในกรณีที่ใชเครื่องโปรแกรมของ อีทีที รุน ET-PGM PIC USB ใหเลือกเปน PICkit 2 

 

เมื่อทําการเลือกเครื่องมือเรียบรอยแลวสามารถสั่ง Program ไดทันที่ โดยใหเลือกที่เมนู Programmer-
>Program แลวรอจนการทํางานเสร็จเรียบรอย จากนั้นก็เลือกสวิตชเพ่ือเปลี่ยนโหมดการทํางานของบอรด
กลับไปยัง Run (LED RUN สีเขียวติดสวาง) แลวกดสวิตชรีเซ็ตที่บอรดจะเห็นบอรดเริ่มตนทํางานทันที โดย
ถาเลือก Jumper ของ LED Test (ENA/DIS) ไวทางดาน ENA จะเห็น LED กระพริบใหเห็นทันท ี
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การกําหนดคา Configuration ใหกับ dsPIC30F2010/4011 
 
 สําหรับ dsPIC30F2010/4011 นั้นจะมีรีจิสเตอรพิเศษจํานวน 4 ชุด ซึ่งเรียกวา Configuration  
Register สําหรับใชกําหนดคุณสมบัติและควบคุมการทํางานของวงจรตางๆใน MCU ซึ่งการกําหนดคา
ใหกับรีจิสเตอรพิเศษทั้ง 4 ชุดนี้ จะตองกระทําในขั้นตอนของการโปรแกรมดวยวิธีการแบบ ICSP หรือจาก
เครื่องโปรแกรมภายนอกเทานั้น 
 โดยสําหรับบอรด ET-BASE dsPIC30F2010/4011 นั้น ในกรณีที่ใชการพัฒนาโปรแกรม รวมกับ
MPLAB และ C30 นั้น จะสามารถกําหนดคาตัวเลือกตางๆใหกับ Configuration Register จาก Code 
คําสั่งที่เขียนขึ้นไดทันท ีดังตัวอยาง 
 
/* Setup Configuration For ET-BASE dsPIC30F2010/4011 */ 
_FOSC(CSW_FSCM_OFF & XT_PLL16);       // Disable Clock Switching 
                                      // Enable Fail-Salf Clock 
                                      // Clock Source=Primary XT + (PLLx16) 
_FWDT(WDT_OFF);           // Disable Watchdog  
_FBORPOR(PBOR_OFF & MCLR_EN);         // Disable Brown-Out ,Enable MCLR 
_FGS(CODE_PROT_OFF);          // Code Protect OFF 
/* End   Configuration For ET-BASE dsPIC30F4011 */ 

 
 โดยรายรายละเอียดและ Keyword ของ Macro ทั้งหมดที่ใชในการกําหนดคา Configuration ของ 
dsPIC30F2010/4011 นั้น ผูใชสามารถดูไดจาก “..\MPLAB C30\support\dsPIC30F\h\p30f2010.h” 
หรือ “..\MPLAB C30\support\dsPIC30F\h\p30f4011.h” 
 
 ***หมายเหต*ุ** สําหรับบอรด ET-BASE dsPIC30F2010/4011 ของ อีทีที นั้น ถาตองการใชงาน
กับโปรแกรมตัวอยางตางๆที่ทางอีทีที จัดทําขึ้นโดยไมเกิดปญหา จะตองเลือก Oscillator เปนแบบ 
“Primary” โดยใช “XT w/PLL 16X-XT crystal oscillator mode with 16X PLL” พรอมกับยกเลิกบิต 
“FWDTEN” เพ่ือปดการทํางานของ Watchdog ดวยเสมอ สวนตัวเลือกอื่นๆสามารถเลือกกําหนดไดตาม
ตองการ 
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FOSC (Oscillator Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80000H 

ทําหนาที่สําหรับใชเลือกกําหนดคุณสมบัติและแหลงกําเนิดของสัญญาณนาฬิกาที่จะปอนใหกับ MCU ของ 
MCU เพ่ือใชเปนสัญญาณนาฬิกาของระบบ ซึ่งตามปรกติแลวระบบสัญญาณนาฬิกาที่สามารถกําหนดใช
กับ dsPIC30F2010/4011 จะสามารถเลือกกําหนดไดหลายแหลงขึ้นอยูกับการออกแบบวงจรใชงาน แตใน
กรณีท่ีใชกับบอรด ET- ฺBASE dsPIC30F2010/4011 น้ัน ระบบสัญญาณนาฬิกาจะไดรับการ
ออกแบบใหใชงานกับตัวกําเนิดความถี่แบบ XTAL คา 7.3728MHz และเพื่อใหสามารถใชงาน 
MCU ไดอยางเต็มประสิทธิภาพและสามารถใชงานกับตัวอยางโปรแกรมตางๆ ท่ีทาง อีทีที จัดทํา
ข้ึน ไดโดยไมเกิดปญหาจะตองเลือกกําหนดแหลงกําเนิดของสัญญาณนาฬิกาเปนแบบ “Primary 
Oscillator” รวมกับ “XT w/PLL 16x”  เทานั้น ซึ่งการเลือกคาดังกลาวเปนการเลือกกําหนดให MCU ใช
สัญญาณนาฬิกาจากวงจรกําเนิดความถี่แบบ XTAL ซึ่ง ตอเขากับขา OSC1 และ OSC2 พรอมทั้งเปดการ
ทํางานของวงจรคูณความถี่ Phase-Lock-Loop ดวยอัตราการคูณ 16 เทา ดวย ซึ่งจะสงผลใหคาความถ่ี
ของสัญญาณนาฬิกาของบอรด ET-BASE dsPIC30F2010/4011 มีคา 117.9648 MHz ซึ่งความถี่ของ
สัญญาณนาฬิกาดังกลาวจะถูกนําไปหารใหเหลือ ¼ กอนที่จะปอนใหกับระบบของ MCU ดังนั้นคาความถ่ี
ของสัญญาณนาฬิกาที่ใชในบอรด ET-BASE dsPIC30F2010/4011 จะมีคาเทากับ 29.4912 MHz สําหรับ
รายละเอียดการเลือกกําหนดคาของบิตตางๆใน PSOC Configurations Register จะมีดังตอไปนี ้
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต FCKSM[1:0] - - - - FOS[1:0] 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - - - FPR[3..0] 

  

ตาราง แสดงคาบิตตางๆของ FOSC Configurations Register 
 

- FCKSM[1:0] ใชสําหรับกําหนดการทํางานของวงจรสลับสัญญาณนาฬิกาและตรวจสอบการ
ทํางานของสัญญาณนาฬิกา   
 0:0 = เปนการเลือกเปดการทํางาน (Enable) ทั้งสวนของวงจรสลับสัญญาณนาฬิกา 

และ วงจรตรวจสอบความผิดพลาดของสัญญาณนาฬิกา(Fail-Safe Clock Monitor) 
 0:1 = เปนการเลือกเปด (Enable) การทํางานของวงจรสลับสัญญาณนาฬิกา แตใน

สวนของวงจรตรวจสอบความผิดพลาดของสัญญาณนาฬิกาจะถูกปด (Disable) ไว 



คูมือการใชงานบอรดไมโครคอนโทรลเลอรรุน ET-BASE dsPIC30F2010/4011 

ETT CO.,LTD -31- WWW.ETT.CO.TH 
 

 1:X = เปนการเลือกปด (Disable)ทั้งสวนของวงจรสลับสัญญาณนาฬิกา และ วงจร
ตรวจสอบความผิดพลาดของสัญญาณนาฬิกา (Fail-Safe Clock Monitor) 

 
- FOS[1:0] ใชสําหรับเลือกแหลงกําเนิดสัญญาณนาฬิกาของ MCU ซึ่งสามารถเลือกได 4 แบบ 

แตสําหรับในกรณีของบอรด ET-BASE dsPIC30F2010/4011 ควรเลือกเปน “1:1” เทานั้น 
 0:0 = เลือกใชสัญญาณนาฬิกาจาก XTAL 32KHz ภายใน MCU 
 0:1 = เลือกใชสัญญาณนาฬิกาจาก RC ภายในแบบยานความถ่ีสูง 
 1:0 = เลือกใชสัญญาณนาฬิกาจาก RC ภายในแบบยานความถ่ีต่ําและใชพลังงานตํ่า 
 1:1 = เลือกใชสัญญาณนาฬิกาจาก Primary Oscillator โดยกําหนดคุณสมบัติการ

ทํางานของวงจรรวมกับบิต FPR[3:0] อีกตอหนึ่ง 
 

- FPR[3:0] ใชสําหรับเลือกการทํางานของสัญญาณนาฬิกาของ Primary Oscillator ซึ่งคาของ
ตัวเลือกในสวนนี้จะมีผลตอการทํางานของ MCU ก็ตอเม่ือเลือกกําหนดแหลงของสัญญาณ
นาฬิกาเปน Primary Oscillator แลว โดยคุณสมบัติการทํางานของ FPR{3:0] มีดังนี ้
 000x = “XLT” เปนการเลือกใช XTAL คา 200KHz-4MHz ตอกับขา OSC1,OSC2 
 001x = “HS” เปนการเลือกใช XTAL คา 10MHz-25MHz ตอกับขา OSC1,OSC2 
 0100 = “XT” เปนการเลือกใช XTAL คา 4MHz-10MHz ตอกับขา OSC1,OSC2 
 0101 = “XT PLL 4x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขากับ 

OSC1 และ OSC2 โดยเปดการทํางานของวงจรคูณความถ่ี (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 4 เทาของความถ่ี XTAL ดวย 

 0110 = “XT PLL 8x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขากับ 
OSC1 และ OSC2 โดยเปดการทํางานของวงจรคูณความถี่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 8 เทาของความถ่ี XTAL ดวย 

 0111 = “XT PLL 16x” เปนการเลือกใช XTAL คาระหวาง 4MHz - 10MHz ตอเขา
กับ OSC1 และ OSC2 โดยเปดการทํางานของวงจรคูณความถี่ (Phase-Lock-Loop) 
ดวยคาอัตราการคูณเปน 16 เทาของความถี่ XTAL ดวย 

 1000 = “ERCIO” เปนการเลือกใชสัญญาณนาฬิกาจากวงจร RC ภายนอก โดยตอ
เขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกต ิ

 1001 = “ERC” เปนการเลือกใชสัญญาณนาฬิกาจากวงจร RC ภายนอก โดยตอ
สัญญาณนาฬิกาเขากับขา OSC1 สวน OSC2 จะใชเปน Output ของสัญญาณ
นาฬิกาที่ได โดยมีคาความถ่ีเปน ¼ หรือ Fosc/4 
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 1011 = “EC” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จากแหลงกําเนิด
ภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน Output ของสัญญาณ
นาฬิกาที่รับจาก OSC1 โดยมีคาความถี่เปน ¼ หรือ Fosc/4 

 1100 = “ECIO” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จากแหลงกําเนิด
ภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 

 1101 = “EC PLL 4x” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จาก
แหลงกําเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทํางานของวงจรคูณความถี่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 4 เทาของความถ่ีที่ปอนใหกับขา OSC1 ดวย 

 1110 = “EC PLL 8x” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จาก
แหลงกําเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทํางานของวงจรคูณความถี่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 8 เทาของความถ่ีที่ปอนใหกับขา OSC1 ดวย 

 1111 = “EC PLL 16x” เปนการเลือกใชสัญญาณนาฬิกาคา 0-40MHz จาก
แหลงกําเนิดภายนอก โดยตอเขากับขา OSC1 สวน OSC2 จะใชเปน I/O ตามปรกติ 
โดยเปดการทํางานของวงจรคูณความถี่ (Phase-Lock-Loop) ดวยคาอัตราการคูณ
เปน 16 เทาของความถี่ที่ปอนใหกับขา OSC1 ดวย 

 
หมายเหต ุ การกําหนดคา Configuration ของ FOSC นั้น จะมีผลตอการทํางานของ MCU 

โดยตรง ซึ่งถากําหนดไมถูกตองจะทําให MCU ไมสามารถทํางานได หรือทํางานไดไมถูกตอง ถึงแมวาผูใช
จะเขียนโปรแกรมไดอยางถูกตองทุกประการก็ตามที โดยในกรณีของการใชงานบอรด “ET-BASE 
dsPIC30F2010/4011” นั้น จะเห็นไดวาวงจรกําเนิดความถ่ีจะถูกออกแบบใหใชตัวกําเนิด XTAL คา 
7.3728 MHz ตอกับขา OSC1 และ OSC2 ของ MCU โดยตรง ซึ่งนั่นก็หมายความวาการกําหนดคา 
Configuration ของ FOSC ที่จะใชงานกับบอรด “ET-BASE dsPUIC30F2010/4011” นั้นจะตองกําหนด
เปน Primary แบบ XT เทานั้น ซึ่งถาเลือกเปนอยางอื่นจะทําให MCU ไมสามารถทํางานได แตในกรณีที่
ตองการใชงานตัวอยางโปรแกรมที่สรางโดย อีทีที จะตองกําหนดการทํางานของ FOSC ใหเปดการทํางาน
ของวงจรคูณความถ่ีจากตัวกําเนิดความถี่คา 7.3728MHz ดวยอัตรา 16 เทาดวย (XT PLL16X) ถาเลือก
เปน XT หรือ XT PLL 4 หรือ XT PLL 8 ถึงแมวา MCU จะสามารถทํางานได แตก็จะสงผลทําใหได
คาความถ่ี ไมตรงกับที่คํานวณไวในโปรแกรมจะทําใหการทํางานของโปรแกรมไมถูกตอง เชน ความเร็วของ
การทํางานชาลง คาอัตรา Baud rate ของพอรตสื่อสารอนุกรมผิดเพ้ียนไปเปนตน ดังนั้นตองกําหนดคา 
Configuration ของ FOSC เปนแบบ “XT PLL16” เสมอ MCU จึงจะทํางานไดอยางถูกตอง 
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FWDT (Watchdog Timer Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80002H 

ใชสําหรับกําหนดการทํางานของ Watchdog ซึ่งในกรณีที่ใชกับบอรด ET-BASE dsPIC30F2010/4011 
และตองการใชงานรวมกับโปรแกรมตัวอยางตางๆที่ทางอีทีทีจัดทําขึ้น ควรกําหนดคาของบิต “PWTEN” ให
เปน “0” เพ่ือปดการทํางานของ Watchdog ไวกอน ซึ่งถาตองการใชงาน Watchdog ผูใชอาจทําการ
ปรับปรุงการทํางานของโปรแกรมที่เขียนขึ้น โดยเพ่ิมคําสั่งสําหรับรีเซ็ตคาการนับของ Watchdog ในสวน
ตางๆของโปรแกรมตามความเหมาะสมแลวจึงสั่งเปดการทํางานของ Watchdog ในภายหลัง โดยคาตัว
เลือกตางๆของ FWDT มีดังนี ้
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - FWPSA[1:0] FWPSB[3:0] 

 
 

ตาราง แสดงคาบิตตางๆของ FWDT Configurations Register 
 

- FWTEN ใชสําหรับกําหนดการทํางานของ Watchdog โดยถากําหนดใหบิตนี้เปน “1” จะเปน
การสั่งเปดการทํางานของ Watchdog ซึ่งในกรณีนี้ผูใชตองเขียนคําสั่งเพ่ือสั่งรีเซ็ตคาการนับ
ของ Watchdog กอนเกิดการ Overflow ในสวนตางๆของโปรแกรมเองดวย ไมเชนนั้นแลวเม่ือ
การนับของ Watchdog เกิดการ Overflow ขึ้น วงจร Watchdog จะสั่งรีการทํางานของ MCU 
ใหเร่ิมตนใหมทันที แตถากําหนดคาของบิตนี้ใหเปน “0” จะเปนการปดการทํางานของ 
Watchdog ซึ่งขอแนะนําใหสั่งปดการทํางานของ Watchdog ไปกอน จนผูใชสามารถเขียน
โปรแกรมไดอยางชํานาญแลว ถาตองการใชงานวงจร Watchdog จึงคอยสั่งเปดการทํางาน
ของ Watchdog ตามตองการในภายหลัง 

- FWPSA[1:0] ใชสําหรับกําหนดคา Prescaler ของวงจร Prescale ชุด A เพ่ือกําหนดคาการ
ลดทอนความถ่ีสัญญาณนาฬิกาที่จะปอนใหกับวงจร Prescale ชุด B เพ่ือใชเปนคาการนับ
ของ Watchdog 
 0:0 = กําหนดการ Prescale เปน 1:1 
 0:1 = กําหนดการ Prescale เปน 1:8 
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 1:0 = กําหนดการ Prescale เปน 1:64 
 1:1 = กําหนดการ Prescale เปน 1:512 

- FWPSB[3:0] ใชสําหรับกําหนดคา Prescale ของวงจร Prescale ชุด B เพ่ือกําหนดคาการนับ
ของ Watchdog โดยสามารถกําหนดได 16 ระดับคือ 
 0000 = กําหนดการ Prescale เปน 1:1 

. 

. 
 1110 = กําหนดการ Prescale เปน 1:15 
 1111 = กําหนดการ Prescale เปน 1:16 

 
หมายเหต ุการทํางานของวงจร Watchdog นั้นจะชวยเพ่ิมประสิทธิภาพการทํางานของ MCU ใน

การใชงานใหเกิดประสิทธิภาพสูงสุด โดยในระบบไมโครคอนโทรเลอรนั้น จะอาศัย Watchdog ชวย
ตรวจสอบการทํางานของ MCU ไมใหหยุดทํางาน ซึ่งเหมาะกับการใชงานวงจรที่ตองทําการอยางตอเนื่อง
ตลอดเวลาเปนเวลานานๆ ซึ่งหลักการทํางานของวงจร Watchdog นั้นจะเปนวงจรนับอิสระวงจรหนึ่ง ซึ่ง
สามารถกําหนดคาการของจํานวนการนับสูงสุด (Time-Out) ที่แนนอนใหกับวงจรได โดยเม่ือวงจรการนับ
ของ Watchdog นับไปจนถึงคาการนับสูงสุดแลวคาการนับจะกลับมาเริ่มตนใหม ซึ่งเรียกวาการ Overflow 
โดยในชวงนี้จะทําใหวงจร Watchdog สงสัญญาณไปรีเซ็ตการทํางานของ MCU ใหเริ่มตนทํางานใหม 

ซึ่งเราจะใชประโยชนจากวงจร Watchdog ในการตรวจสอบการทํางานของ MCU โดยการเขียน
คําสั่งสําหรับสั่งรีเซ็ตคาการนับของ Watchdog แทรกไวในสวนตางๆของโปรแกรม กอนที่คาการนับของ 
Watchdog จะเกิดการ Overflow ขึ้น แตถาหากวา MCU เกิดการหยุดการทํางานขึ้น ไมวาจะเกิดจาก
สาเหตุใดก็ตาม MCU ก็จะไมสามารสงสัญญาณไปรีเซ็ตคาการนับของ Watchdog ไดดังนั้น MCU ก็จะถูก 
Watchdog รีเซ็ตใหกลับมาเริ่มตนทํางานใหมไดอีก 

แตอยางไรก็ตามในการพัฒนาโปรแกรมใชงานนั้น ถาผูพัฒนาโปรแกรมยังไมมีความชํานาญในการ
เขียนโปรแกรมเพียงพอ โดยเฉพาะในระหวางทีเ่ปนชวงเร่ิมตนของการเรียนรูนั้น ควรสั่งปดการทํางานของ 
Watchdog ไวกอน ไมเชนนั้นแลวจะเปนการเพ่ิมความสับสนใหกับผูใชได เนื่องจากถามีการแทรกคําสั่ง
สําหรับรีเซ็ตคาการนับของ Watchdog ไมเหมาะสมก็อาจทําให Watchdog สั่งรีเซ็ตการทํางานของ MCU 
ในขณะที่ MCU กําลังทํางานตามโปรแกรมปรกติอยูก็เปนได ดังนั้นขอแนะนําใหสั่งปดการทํางานของ 
Watchdog ไวกอน จนเม่ือสามารถพัฒนาโปรแกรมรวมกับวงจรสวนอื่นๆ จนโปรแกรมสามารถทํางานได
อยางถูกตองครบทั้งหมดแลว จึงคอยเปดการทํางานและแทรกคําสั่งสําหรับ รีเซ็ตคาการนับของ Watchdog 
ในภายหลัง ซึ่งตัวอยางโปรแกรมตางๆที่ทาง อีทีที จัดทําขึ้นนั้นก็ไมไดจัดการเรื่อง Watchdog ไวดวย
เชนเดียวกัน ดังนั้นควรกําหนดคา Configuration ของ FWDT ใหปดการทํางานของ Watchdog ไวดวย 
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FBORPOR (BOR and POR Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F80004H 

ใชสําหรับกําหนดการทํางานของวงจร Power-ON Reset และ Brown-Out Reset 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต MCLREN - - - - PWMPIN HPOL LPOL 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต BOREN - BORV[1:0] - - FPWRT[1:0] 

 
 

ตาราง แสดงคาบิตตางๆของ FBORPOR Configurations Register 
 

- MCLREN ใชสําหรับกําหนดการทํางานของขาสัญญาณ MCLR โดยถากําหนดใหบิตนี้มีคา
เปน “1” จะเปนการเปดการทํางาน (Enable) ของขาสัญญาณ MCLR เปน External Reset 
ตามปรกติ แตถากําหนดใหบิตนี้มีคาเปน “0” จะเปนการปดการทํางาน (Disable) ของ
ขาสัญญาณ MCLR 

- PWMPIN ใชสําหรับกําหนดการทํางานของขาสัญญาณ PWM ในระหวางการรีเซ็ต ซึ่งใน 
dsPIC30F2010 จะมีอยู 3 ชุด โดยถากําหนดใหบิตนี้มีคาเปน “1” จะเปนการกําหนดใหขา 
Output ของ PWM ถูกควบคุมโดยวงจร Input/Output และมีสถานะเปน Tri-State ในระหวาง
เกิดการรีเซ็ตอยู แตถากําหนดใหบิตนี้มีคาเปน “0” จะเปนการกําหนดใหขา Output ของ PWM 
ถูกควบคุมจากวงจร PWM โดยในขณะเกิดการรีเซ็ตอยูจะมีสถานะเปน Output  

- HPOL ใชสําหรับกําหนดลักษณะการทํางานของขา PWMH เม่ือเกิดการทํางาน (Active) โดย
ถากําหนดใหบิตนี้มีคาเปน “1” จะเปนการกําหนดใหขาสัญญาณ PWMH เปน High ในขณะ 
Active แตถากําหนดใหบิตนี้เปน “0” จะเปนการกําหนดให PWMH เปน Low ในขณะ Active 

- LPOL ใชสําหรับกําหนดลกัษณะการทํางานของขา PWML เม่ือเกิดการทํางาน (Active) โดย
ถากําหนดใหบิตนี้มีคาเปน “1”จะเปนการกําหนดใหขาสัญญาณ PWML เปน High ในขณะ 
Active แตถากําหนดใหบิตนี้เปน “0” จะเปนการกําหนดให PWML เปน Low ในขณะ Active 

- BOREN ใชสําหรับกําหนดการทํางานของวงจร Brown-Out Reset โดยถากําหนดเปน “1” จะ
เปนการเปดการทํางานของ Brown-Out แตถากําหนดเปน “0” จะเปนการปดการทํางานของ 
Brown-Out 
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- BORV[1:0] ใชสําหรับกําหนดระดับคาของแรงดันที่จะใชเปนจุดอางอิงในการตรวจสอบความ
ผิดพลาดของระดับแหลงจายของวงจร Brown-Out Reset 
 0:0 = ใหวงจร Brown-Out ทํางานเม่ือแรงดันต่ํากวา 4.5V 
 0:1 = ใหวงจร Brown-Out ทํางานเม่ือแรงดันต่ํากวา 4.2V 
 1:0 = ใหวงจร Brown-Out ทํางานเม่ือแรงดันต่ํากวา 2.7V 
 1:1 = ใหวงจร Brown-Out ทํางานเม่ือแรงดันต่ํากวา 2.0V 

 
- FPWRT[1:0] ใชสําหรับกําหนดคาเวลาการทํางานของวงจร Power-ON Reset 

 0:0 = เปนการปดการทํางาน (Disable) ของวงจร Power-ON Reset 
 0:1 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 4mS 
 1:0 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 16mS 
 1:1 = เปนการเลือกเปดการทํางานของวงจร Power-ON Reset โดยมีคาเวลา 64mS 
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FGS (General Code Segment Configuration Register)  
เปน Configurations Register ขนาด 24 บิต โดยมีตําแหนงแอดเดรสของรีจิสเตอรอยูที่ F8000AH 

ใชสําหรับกําหนดระบบการปองกันขอมูลของหนวยความจําใน MCU 
 

บิตขอมูล 23 22 21 20 19 18 17 16 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 15 14 13 12 11 10 9 8 
ชื่อบิต - - - - - - - - 

 

บิตขอมูล 7 6 5 4 3 2 1 0 
ชื่อบิต - - - - - - GCP GWRP 

 
 

ตาราง แสดงคาบิตตางๆของ FGS Configurations Register 
 
 

- GCP ใชสําหรับกําหนดการปองกันการอานขอมูลของหนวยความจําโปรแกรม หรือ Flash 
Memory จากภายนอก โดยถากําหนดใหบิตนี้เปน “1” จะเปนการปด (Disable) ระบบปองกัน
การอานขอมูลจากหนวยความจํา Flash แตถาเลือกกําหนดใหบิตนี้เปน “0” จะเปนการเปด 
(Enable) ระบบปองกันการอานขอมูลจากหนวยความจํา Flash ซึ่งจะทําใหไมสามารถสั่งอาน
ขอมูลจากหนวยความจํา Flash ใน MCU จากภายนอกได โดยถาเลือกกําหนดใหบิตนี้มีคา
เปน “0” แลวจะไมสามารถสั่งเปลี่ยนคาใหกลับมาเปน “1” ไดอีก นอกจากจะสั่งลบขอมูลออก
จากหนวยความจําทั้งหมดเสียกอน ซึ่งหลังจากสั่งลบขอมูลในหนวยความจําโปรแกรมทั้ง
หมดแลวบิตนี้จะมีคาเปน “1” โดยอัตโนมัติ 

- GWRP ใชสําหรับกําหนดการปองกันการเขียนขอมูลของหนวยความจําโปรแกรม หรือ Flash 
Memory โดยถากําหนดใหบิตนี้เปน “1” จะเปนการปด (Disable) ระบบปองกันการเขียน
ขอมูลใหมใหกับหนวยความจํา Flash แตถาเลือกกําหนดใหบตินี้เปน “0” จะเปนการเปด 
(Enable) ระบบปองกันการเขียนขอมูลใหกับหนวยความจํา Flash ซึ่งจะทําใหไมสามารถสั่ง
เขียนขอมูลใหกับหนวยความจํา Flash ใน MCU เพ่ิมเติมไดอีกจนกวาจะสั่งลบขอมูลเดิม
ทั้งหมดออกเสียกอน โดยถาเลือกกําหนดใหบิตนี้มีคาเปน “0” แลวจะไมสามารถสั่งเปลี่ยนคา
ใหกลับมาเปน “1” ไดอีก นอกจากจะสั่งลบขอมูลออกจากหนวยความจําทั้งหมดเสียกอน ซึ่ง
หลังจากสั่งลบขอมูลในหนวยความจําโปรแกรมทั้งหมดแลวบิตนี้จะมีคาเปน “1” โดยอัตโนมัต ิ
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RC14 16

RD0 23

RD1 18

RD2 22

RD3 19

RE0 38

RE1 37

RE2 36

RE3 35

RE4 34

RE5 33

RE8 17

RF0 30

RF1 29

OSC214

OSC113

VDD11

VDD21

VDD32

AVDD40

AVSS39

VSS12

VSS20

VSS31

MCLR1

RB6 8

RB7 9

RB8 10

RF2 26

RF3 25

RF4 28

RF5 27

RF6 24

DSPIC30F4011

RD2
RD3

RB6
RB7
RB8

RB6 RB7

RF0
RF1

RF4

RF5

RF6
RB8

R/W

RD2
RD3

RX2
TX2

1
2
3
4

UART2

+VDD

RXD
TXD

RX2
TX2

0.1uF

1 2
3 4
5 6
7 8
9 10

PORT-RE

RE1
RE3
RE5

RE0
RE2
RE4
RE8

+AVDD

1 2
3 4
5 6
7 8
9 10

PORT-RF

RF2 RF3

+VDD

RF1

RF5

RF0

RF4
RF6

RB0 2

RB1 3

RB2 4

RB3 5

RB4 6

RD0 15

RD1 14

RE0 26

RE1 25

RE2 24

RE3 23

RE4 22

RE5 21

RE8 16

RC13 11

RC14 12

RF2 18

RF3 17

VDD13

VDD20

AVDD28

VSS8

VSS19

AVSS27

OSC210

OSC19

MCLR1

RB5 7

DSPIC30F2010

+VDD

0.1uF

+AVDD

0.1uF

0.1uF

10uF

1R

7.3728 M
H

z

22pF

22pF

TEST

PW
R ET-BASE dsPIC30F2010/4011

ETT CO.,LTD(WWW.ETT.CO.TH)
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Eakachai Makarn

1.0


